
1 

Otter Travel Desk 
travel@csumb.edu

Table of Contents 

TRAVEL REQU EST .........................................................................................................................................................3 

CREATING A TRAVEL REQUEST........................................................................................................................................................................................... 3 
Request Header ...................................................................................................................................................................................................... 3 
Adding Projected Expenses to Travel Request  .................................................................................................................................................. 7 
Air Ticket Expense................................................................................................................................................................................................... 8 
Meals ........................................................................................................................................................................................................................ 9 
Hotel Reservation Expense ................................................................................................................................................................................... 9 
Car Rental Expense...............................................................................................................................................................................................10 
Hospitality Expense ..............................................................................................................................................................................................10 
Expense Allocations..............................................................................................................................................................................................11 

REQUEST DETAILS...........................................................................................................................................................................................................13 
Edit Request Header ............................................................................................................................................................................................13 
Cash Advance ........................................................................................................................................................................................................13 
Request Timeline ..................................................................................................................................................................................................14 
Audit Trail  ..............................................................................................................................................................................................................14 
Allocation Summary .............................................................................................................................................................................................15 

PRINT/SHARE.................................................................................................................................................................................................................15 
ATTACHMENTS ...............................................................................................................................................................................................................15 
ALERT TYPES ..................................................................................................................................................................................................................16 
SUBMITTING REQUEST FOR APPROVAL ............................................................................................................................................................................17 
TRAVEL REQUEST TYPES..................................................................................................................................................................................................17 

International Travel  .............................................................................................................................................................................................17 
Mileage Blanket....................................................................................................................................................................................................18 
Liability Only/Unfunded Travel Request...........................................................................................................................................................18 

ADDING AND REMOVING DELEGATES ..............................................................................................................................................................................20 
Adding a Delegate................................................................................................................................................................................................20 
Removing Delegation Rights  ..............................................................................................................................................................................21 
Delegate For Another Person  .............................................................................................................................................................................22 

ACTING AS A DELEGATE ..................................................................................................................................................................................................23 
EDIT OR REMOVE A SUBMITTED REQUEST .......................................................................................................................................................................24 

Recall a Request....................................................................................................................................................................................................24 
Replacing a Request.............................................................................................................................................................................................24 
Cancel a Request ..................................................................................................................................................................................................25 
Closing/Inactivating a Request ..........................................................................................................................................................................26 

APPROVING A TRAVEL REQUEST ......................................................................................................................................................................................27 

EXPENSE REPORTS ...................................................................................................................................................... 29 

CREATING AN EXPENSE REPORT ......................................................................................................................................................................................29 
Expense Report from Approved Travel Request ..............................................................................................................................................29 
Report Header.......................................................................................................................................................................................................29 

TRAVEL ALLOWANCES.....................................................................................................................................................................................................30 
Importing the Travel Itinerary ............................................................................................................................................................................30 
Entering the Travel Itinerary  ..............................................................................................................................................................................31 

Concur User Guide

January 02, 2025



  

2 
 

Adjusting Allowances...........................................................................................................................................................................................32 
REPORT DETAILS.............................................................................................................................................................................................................34 

Report Totals .........................................................................................................................................................................................................34 
Report Timeline/ Tracking Status of an Expense Report after Submission ................................................................................................35 
Audit Trail  ..............................................................................................................................................................................................................35 
Linked Requests/Manage Requests  ..................................................................................................................................................................36 
Linked Cash Advances..........................................................................................................................................................................................36 

ADDING EXPENSES..........................................................................................................................................................................................................37 
Adding Expenses from within the Expense Report  .........................................................................................................................................37 
Meals Charged on a Campus Issued Card Expense Type ...............................................................................................................................40 
To Create a Car Mileage Expense ......................................................................................................................................................................41 
Expensing a Cash Advance..................................................................................................................................................................................43 

ITEMIZING EXPENSES ......................................................................................................................................................................................................44 
To itemize a general expense: ............................................................................................................................................................................45 
To itemize a hotel expense: ................................................................................................................................................................................45 

ALLOCATING EXPENSES ...................................................................................................................................................................................................48 
ATTACHMENTS ...............................................................................................................................................................................................................50 

Managing Attachments  ......................................................................................................................................................................................50 
Electronic Receipts (E-Receipt)...........................................................................................................................................................................51 
Missing Receipt Declaration ...............................................................................................................................................................................53 
Send Receipt Images to Travelers Available Receipts Library  ......................................................................................................................53 

PRINTING OR SHARING AN EXPENSE REPORT ...................................................................................................................................................................54 
To Preview and Print the Expense Report ........................................................................................................................................................54 

REVIEWING/APPROVING AN EXPENSE REPORT.................................................................................................................................................................54 
Reviewing an Expense Report ............................................................................................................................................................................54 
Approving an Expense Report ............................................................................................................................................................................55 
Sending Back an Expense Report.......................................................................................................................................................................55 
Adding an Additional Reviewer/Approver Step (for HR approvers only) ....................................................................................................56 
Adding An Additional Approver (for both HR Approver and Budget Approver/Cost Object Approver[COA]):  ....................................57 

EXPENSE DELEGATES ......................................................................................................................................................................................................58 
Adding an Expense Delegate ..............................................................................................................................................................................58 
Removing Delegation Rights  ..............................................................................................................................................................................60 
Acting as a Delegate ............................................................................................................................................................................................61 
Delegate Roles ......................................................................................................................................................................................................62 

CORRECTING AND RESUBMITTING AN EXPENSE REPORT ...................................................................................................................................................63 
SPECIAL TRAVEL SITUATIONS...........................................................................................................................................................................................64 

Travel Prior to the Per Diem Policy change......................................................................................................................................................64 
Converting Foreign Currency Transactions  ......................................................................................................................................................65 

SUPPORT DOCUMENTS FOR INTER CAMPUS FUND TRANSACTION (IFT) SUBMISSION.........................................................................................................66 
CREATING AN ALLOCATION FAVORITE..............................................................................................................................................................................67 
 



3 

TRAVEL REQUEST 

Creating a Travel Request 

Note that the screen captures included in this document may look slightly different on-screen due to the fluid nature 

of the Concur pages which will resize and adjust based on the window or monitor size.  

Request Header 

1. To create a request, use one of the following methods:

a. On the top banner select Home > Requests, then on the resulting page select the “Create New
Request” button at the right

b. OR select the “Create” button and “Start a Request”. If you are unsure if a request has already

been generated, use method and review the open requests before starting a new one.

2. The Request Header window appears.

3. On the “Create New Request” window, enter your travel information in the fields provided. All fields
identified with an asterisk (*) are required.
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4. After completing the fields, select “Create Request”.

5. To edit the Request Details, select the “Request Details” drop-down menu, then “Edit Request Header”.
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a. Or, by selecting the title

Request Header Fields Defined: For detailed information on each of the fields, see the field descriptions 
in the table below. 

Field Name Description 

Request/Trip Name Enter a meaningful trip name, similar to a name given to a travel expense report. 
Your department may implement a standard naming protocol. Suggested naming 
convention Destination City, State and dates of Travel (ex. Long Beach, CA 5/18-
5/21). 

Trip Type Select from the drop-down list. In-State-Travel within CA, Out-of-State- Travel to 
other US State or Territories (ie. Puerto Rico), International-Travel to a Foreign 
Country 

Travel Start Date Date business expenses start. If personal days precede business dates, please be 
sure to still set travel start date to the date you leave for the trip.  

Travel End Date Date business expenses end. If personal days are after business dates, please be 
sure to still set travel end date to the date you return from trip.  

Traveler Type Select from the drop-down list. 

Trip Purpose Select from the drop-down list. 
1. Athletics – any athletics or team travel, except recruitments.

2. Campus Visits (Chancellor’s Office Only)

3. Competition – non-athletic competition such as debate, dance, etc.

4. Conference – a formal meeting that typically takes place over multiple

days and involves people with a shared interest, especially one held

regularly by an association or organization.

5. Employee Recruitment/Interview – only intended for non-employee

policy. Global audit rule exists to prevent usage on employee policy.

6. Field Research - the collection of data outside a laboratory, library, or

workplace setting.

7. Field Trip – triggers group travel guidelines, typically includes travelling

with students.

8. Meeting – in person gathering of two or more people outside of the local 

area to achieve a common goal/business purpose, such the members of

a committee. Typically includes multiple expense types (example: air

travel, mileage, overnight stay)
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Field Name Description 

9. Mileage/Parking Only – intended for mileage, parking, tolls for day trip

(not overnight) such as travelling to local or a satellite location. May be

reoccurring.

10. Other – selected when no other category applies.

11. Presentation – intended for speakers that travel to another location to

participate or present a topic.

12. Professional Development – targeted training session, career training,

continuing education, classes/workshops not part of a conference.

13. Recruiting – athletics, student, outreach or other.

14. Unintended Transaction – a non-travel related credit card expense which

must be reconciled within Concur. Typically, the incorrect payment

method was selected by mistake.

If Faculty, is class 
covered?  

Only Required for Faculty.  Select from the drop-down list. 

Personal Date of 
Travel  

Enter all dates which are personal. If none, place NA in field. 

Destination City/State If you anticipate travelling to more than one city and/or country, enter where 
you plan to spend the majority of your travel time.  

Final Destination 
Country  

The country will pre-populate based on the destination city selected. 

Are you traveling to a 
banned state?  

Select “No” from drop-down list unless travel was prior to the date the ban was 
repealed (9/14/23). This option will be removed beginning in FY24. 

Are you traveling with 
students?  

Select from the drop-down list. 

Chartfield Chartfield String will pre-populate based on your dept. If necessary, changes can 
be made by traveler or approver.  
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Adding Projected Expenses to Travel Request 

1. The Expected Expenses page will display. Select “Add”. At least one projected expense must be added to
submit the request.

2. From the drop-down list, select the appropriate category to best project expenses for your travel or using
the search function.
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3. Continue to “Add” expenses until the request reflects the full anticipated cost for the trip that the
traveler is seeking to be paid by the university.  Enter meaningful estimates for the expense. Note: If the

budget is limited, please make sure your travel request clearly describes the limitation.

Air Ticket Expense

1. Select Round Trip, One Way or Multi City. (optional)

2. Enter the “From” and “To” locations in the Outbound section. If round trip, populate the Return section

also. (optional)

3. Enter Outbound and Return flight “Date(s)” and “Depart at” times. (optional)

4. Enter total airfare “Amount”.

5. Add “Comments” as necessary.

6. Select “Save” to add the expense to your Travel Request form.



Meals

1. The destination should carry in from the header, but if the destination is different, enter the
“Destination”.

2. If appropriate, enter the personal (# of days) for reduction. Reason…

3. Enter “Comments” if necessary. (optional)

4. Select “Save”. The system will calculate the max M&I based on destination and dates of travel.

Hotel Reservation Expense 

1. Enter Check-In date in the “Travel Start Date” and Check-Out date “Travel End
Date” fields.(optional)

2. Enter or select the lodging “City”. (optional)

3. Relevant notes can be provided in the “Comment” field.

4. Enter the “Maximum Nightly Rate” ($333 for domestic).
If requesting an exception, enter the reason in the “Over Rate Comment” field.

5. Enter the anticipated “Amount” for the lodging.

9
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6. Currency will default to US Dollar.

7. Select “Save” at the bottom or upper right to add the expense to your Travel Request form.

Car Rental Expense 

1. Enter the “City” where you plan to pick up the car. (optional)

2. Select the “Travel Start Date”. (optional)

3. Select the “Travel End Date” for when you plan to drop off the car. (optional)

4. Type “Comments” as necessary (optional).

5. Enter the anticipated “Amount” for the car rental.

6. Currency will default to US Dollar.

7. Select “Save” to add the expense to your Travel Request form.

Hospitality Expense 

1. Travel Start Date and Travel End Date automatically populate.

2. Enter “Amount”.

3. Add the description and business purpose for the hospitality to the “Comments” field.
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Expense Allocations 

1. When adding expenses, the “Allocate” feature can be selected to designate different chartfields for
expenses if there is a need to split the funding of a travel transaction.

2. Select the “Add” button to add the first chartfield string.
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3. Select the Chartfield String, then select “Save”. Only chartfields with an asterisk (*) are required.

4. Add all desired chartfield distributions and you will notice that they are automatically evenly distributed.
Change the distribution percentage or choose to allocate it by amount using the button in the upper left.

Once finished specifying the allocations, select “Save”.
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Request Details 

Edit Request Header 

1. To edit the Request Details, select the “Request Details” drop-down menu, then “Edit Request Header”
or by selecting the title.

Cash Advance 

In most cases a travel advance is no longer needed as many travelers should have a Concur Travel card. However, 

cash advances will still be available in exceptional cases (specifically for 

team/competitive travel) and may be entered on the travel request. To be eligible to 

request a cash advance an approval from the Accounts Payable  {Travel Department} 

department is needed. Your Concur settings must be updated to reflect this option by 

your campus Concur Admin. 

1. To request a Cash Advance in Concur, you must email {Travel Email Address} to
add the Cash Advance option in your Concur. The travel group will email to let you

know when you have access (please give 24-48 for access).

2. Once you receive an email response confirming access to create a cash advance,

from the Concur Home page open the Travel Request.
Note: If one has not been created, proceed to the Create a Travel Request section.

3. Navigate to Request Details drop-down menu and select “Add Cash Advance”.

4. Enter the “Cash Advance Amount” and reason for advance. Select “Save”. This will add the cash amount
to the request.

Note: If you do not have a Travel Card, and are eligible, fill out the appropriate campus request form and 

allow 2 weeks for delivery. Allow yourself enough time to obtain the card before your travel dates.  
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Request Timeline 

This timeline will display the approval workflow and identify the steps which have been completed or are 

outstanding.  

1. Navigate to Request Details drop-down menu and select “Request Timeline”.

Once a request is submitted, the request will route in the following order: {Adjust Based on 

Campus workflow} 

1. The employee’s supervisor.

2. The report will route to the cost object approver(s) or those names identified in the
Delegation of Authority (DOA) as approvers.  DOA approvers are based on the chartfield

entered on the Request Header tab as well as any additional chartfield allocated at the
individual line item level on the Expenses tab.

3. If international travel or other additional review is specified for the request, those approvers will review.

This includes campus approvers or Chancellor’s Office Risk Management for war risk countries.

Audit Trail 

The audit trail will display the timestamps of certain actions taken on the travel request.  

4. Navigate to Request Details drop-down menu and select “Audit Trail”.

5. The date/time of the approvals and the approver names will display.
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Allocation Summary 

If a line has an allocation, the Allocation Summary will display in the Request Details menu.  
Using this option will display a summary of any chartfield splits that might have been added 

to the request expenses. 

1. Navigate to Request Details drop-down menu and select “Allocation Summary”.

Print/Share 

From the Print menu, select the “CSU-Request Printed Report” 

option to save the travel request summary as a PDF or share as 

deemed necessary. Attachments are not included as part of this 

saved report. If attachments are needed, save the attachments 

separately. 

Note: Reports in Concur will be retained in the system according to CSU retention guidelines. Printing or saving in 

duplicate is optional and in most cases is not necessary. 

Attachments 

The Attachments > Attach Documents menu option launches 

window to browse then “Upload and Attach” files that 

support the trip request (use the button to search). 

Documents may include a conference registration showing 

location/dates of trip, or an itinerary for international travel, 

or any other support document that is helpful to have on 

hand for approvers. 
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1. Valid file types are specified in the window and are pdfs or image files (.png, .jpg or .jpeg, .pdf, etc). Note
that there is a 5MB limit.

2. Select “Close” once files have been uploaded.

3. Once documents have been uploaded, the Attachments menu displays a small red
image to identify that the request has document attachments.  The menu changes to

have three options – View Documents, Attach Documents and Delete Documents
which can be used to update or remove previously uploaded attachments.  *Note:
Documents cannot be removed once the Request is submitted or Appoved,

however, documents can be added at any time.

Alert Types 

Alerts are messages triggered by certain elements of your trip. There are different types of alerts.  

1. HARD STOP: If an alert displays in red, it is required.  This means an action must be taken before a

request or expense report can be submitted. Example of hard stop on expense report:

2. WARNING: A yellow/orange alert displays communication related to your trip components advising you
to read and take action.

A yellow alert panel is a warning or information only.  For example, an alert can communicate the need
to add comments and explain the trip, or to attach files, etc. The alert count will change as requirements

are met. Note: Most yellow warnings will not clear, however, they will not prevent you from submitting
the Request.
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Submitting Request for Approval 

1. Once the travel request is complete, select the “Submit Request” button.

2. See example below of a submitted travel request with multiple lines.

Travel Request Types 

International Travel 

1. Travel to international destinations generally follow the same process for creating a travel request as a
domestic trip, with a few deviations.

2. In the Request Header section, Trip Type should be designated as “3-International”.

3. Request must have an attachment with an itinerary that communicates dates and points of destination.

The Risk Management office will utilize this data to facilitate working with a traveler for necessary foreign
travel insurance requirements and other necessary components for a trip.

4. All expenses should be noted in USD. In the Expense Report stage currency conversions are more
relevant with actual expenses. The OANDA Currency Converter may be used in either instance.
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Mileage Blanket 

1. Blanket Travel Request for Mileage

2. Blanket mileage requests can be used for recurring activity for a given fiscal year. These mileage requests

are intended to facilitate ongoing mileage reimbursement claims for employees performing supervisory
responsibilities for campus student placements. An example of this would be driving throughout the state

to observe and meet with student teachers/interns and mentor teachers.

3. Enter general information about the activity and note the time frame from August through May

(academic year) or July through June (fiscal year). Note the Trip Purpose as “Mileage Only” and in the
destination field select “Multiple Locations (Mileage Only), CA”.

4. Add relevant comments and select “Create Request”.

5. In the Expected Expenses section, select “Add”.

6. Select “Personal Car Mileage”.

7. In the New Expense window, enter the estimated mileage distance for the entire year. Prior year could

be used as a reference point and should be adjusted for any known variances for a given year.

8. Select “Save”.  Cost will automatically calculate once “Save” is selected.

Liability Only/Unfunded Travel Request 

Travel with no funding from the campus, e.g. travel that is fully funded by outside sources or by the traveler needs 

to be evaluated for connection to University business. If directly connected to university business that supports 

campus mission, a travel authorization should be completed to communicate time away from campus. This will 

assist with campus duty of care objectives. 

Note: Accepting travel gifts from a 3rd party may result in a conflict of interest (COI).  Please refer to further 

information about COI. 
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1. Follow steps to “Create a Travel Request”. Once trip details have been added to the travel request
header, in the Expected Expenses section select “Add”, then select “Liability/Unfunded” from the

expense list.

2. Add $0 to the “Amount” and make a note in the “Comments” field for reference.

3. Once trip is approved and you are notified via email it is best to go back into Concur and follow the steps

below for marking the request as Closed/Inactivate Request. The request will close on day 61 post trip.
Closed/Inactivate Request will prevent the traveler from receiving expense report notifications in relation
to this request. Marking closed will reflect there are no expected expenses and will eliminate those

expense report reminders.
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Adding and Removing Delegates 

Adding a Delegate 

There may be a time when you want another person to assist with requesting or processing travel. To delegate 

access to another person, complete the following steps: 

1. Open your profile.

2. Using the left menu, then select the “Delegates” tab.

a. Navigate to Request Delegates or Expense Delegates to assign another employee rights to

request travel or to process an expense report on your behalf. Note that delegating expense also
delegates request.

3. Select “Add”, then begin to type the person’s email address, employee ID or name.

4. Select the correct name from the list.
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5. After selecting the name, enter checkmarks in the boxes to the right of the name to grant access.

6. To place a limit on the approval timeframe, use the “Can Approve Temporary” date fields. Approvers can
delegate “preview” rights to a person of any level (approver or not).  Note: Not all options may be

available to all users. Delegate options are based on the individual user profiles access within Concur. For
example, if an approver wants to delegate responsibility to another person, they must be designated in

the Concur system as an approver.

7. Continue adding names as needed.

Removing Delegation Rights 

1. Open your profile and select Profile Settings.

2. Using the left menu, then select the “Delegates” tab.

a. Navigate to Request Delegates or Expense Delegates.
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b. Select any names for which you want to remove access. Select “Delete”.

Delegate For Another Person 

1. The “Delegate For” tab will display the individuals which have granted you Delegate access to their
profile.

2. Select any names for which you want to remove access. Select “Delete”.
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Acting as a Delegate 

If you have been assigned to work as a delegate, your delegator will define which tasks you can complete, such as 

preparing reports or approving, etc.  

To work as a delegate: 

1. Select the “Profile” in the upper right.

2. Under “Act as Another user”.

3. Select the appropriate delegator's name from the drop down or type the name in the following format:

Last Name,First Name

4. Select “Switch” to begin working as the other person.

5. Notice that the Profile menu now displays Acting as and displays the name of the employee who

delegated their access.

6. You are now officially working on behalf of that person. Complete the normal processes for creating the
request as noted in the section above, Creating a Travel Request.

7. Once the request is built, the Delegate can use the “Notify Employee” button to let the traveler know the

Request is ready to submit. The Traveler must certify and submit their own travel request.

8. To return to your own tasks, select “Acting as”, then select “Myself” and “Switch”.
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Edit or Remove a Submitted Request 

If there is a need to revisit and alter a request, because dates, locations, or significant cost changes are necessary 

there are a few options. 

You cannot change or cancel a Request that has been submitted unless you Recall it first. You can only recall a 

request that is not in “Approved” status. If the request has been fully Approved, you will need to take different steps 

as noted below in Replacing a Request. 

Recall a Request 

1. Select the Request Name that has been submitted from the Manage Requests page.

2. Select “Recall Report”. The “Recall Report” option is only available once the report is submitted.

3. Select “Yes” to confirm the Recall.  The status of the request is updated to Sent Back to User.

4. Make any necessary changes, then select “Submit Request”.

Replacing a Request 

This step is only needed in the case where a request has been fully approved and details have changed in such a way 

that the prior approved request is no longer valid. 

1. On the Request Page, select to open the request you would like to copy.

2. Select “Copy Request”.



25 

3. Enter a different “New Request Name” (so you can differentiate between old and new), enter the
“Starting Date”, then select “Expenses” checkbox. This helps cut down on duplicative data entry if there

are alike expenses between old and new. Select the “Create New Request” button to complete the
process.

4. Make any necessary updates to the new request and “Submit Request” to submit for approval.

Cancel a Request 

If a trip is canceled or elements have changed so significantly that you need to replace a request as noted in the 

prior section, please cancel the request by going back to the Requests tab and open the request.  

1. On the Request Page, select the “More Actions” drop-down and select “Cancel Request”.

2. For travel reservations, refer to the Trip Library and make sure to cancel or change them based on the
changed elements. They will be noted as cancelled/withdrawn after completion of this step. This will

ensure the campus/employee does not incur unnecessary expenses for not canceling on time.

3. From the Home Menu, select “Travel”.
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4. Using the Navigation menus across the top, select “Trip Library”.

5. Select the date range, select “Cancel” under the Action column. Check the “Include Withdrawn Trips”
checkbox and select “Search” to see all travel itineraries and withdrawn trips.

Closing/Inactivating a Request 

The system will automatically close open travel requests 61 days after a trip is complete. Reminder, Expense Reports 

need to be submitted within 60 days from travel end date. If all relative expenses have been submitted a user can 

manually close/inactivate the request. This is not a required step.  

1. Select the Request tab, selecting the specific request and select the “Close Request”. This option is
context sensitive. It will not be visible if it is not an option.

2. The difference between this status and cancelation is that cancelation signals a true recall of an

anticipated trip. Closing/inactivating means the trip is complete. If by chance an expense needs to be
submitted after a request is closed, please reach out to the Accounts Payable/Travel {Department Name}

team for assistance.
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Approving a Travel Request 

The approver will see requests awaiting approval under Authorization Requests on the Concur 

home page. Trip elements cannot be booked until approval occurs.  

1. Select the Request you wish to approve by selecting the Request Name.

2. Review the Request Header and the Expense Summary tabs. Things to consider:

a. Review destination and see if high hazard destinations are noted.

b. Take note of any personal days and consider that estimated costs are prorated accordingly (i.e.
daily meal allowances, incidentals, etc.).

c. Review attachments to obtain further information about purpose of trip.

d. Review all expenses for reasonableness and completeness.

3. There are three approval options:

a. Approve – approve the Request

b. Approve & Forward – Approve and Forward the Request for additional approval.  In the
User-Added Approver box, type in the last name of the approver and select from the
dropdown box. You can only select users who are already designated as approvers in the
system.

c. Send Back Request – Return the Request to the traveler. Use the Comment field in the
Send Back Report window to explain the reason the report is being returned, then select
OK.
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Once Travel Requests have been acted on by the approver, notification regarding the status will be 

sent to the traveler (and delegate if opted into notifications) and the status will be noted on the 

traveler’s Manage Requests page.  
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EXPENSE REPORTS 

Creating an Expense Report 

All CSU related travel for faculty and staff must have an approved Travel Request before an expense report can be 

created. 

Per CSU Travel Procedures, Section IX; A "Travel Expense Claim must be submitted to the campus Travel 

Reimbursement office within 60 days of the end of a trip unless there is recurrent local travel, in which case claims 

may be aggregated and submitted monthly."  

Please be aware Approved Travel Requests will automatically close on day 61 after the travel end date. In order to 

submit a late expense report, the request will have to be re-opened. The request will not be re-opened until 

exception approval has been obtained from Division VP and CFO. 

Expense Report from Approved Travel Request 

1. From the Home Menu, select “Requests”.

2. Select the approved tile for the trip to be sourced to an expense report.

3. Once open, select “Create Expense Report”.

Report Header 

All the header details from the request are brought to the expense report header. If you need to edit the details, 

select the “Report Details” menu, “Report Header” option, or select on the Report Number. 
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Travel Allowances 

All employee expense reports require a travel allowance if requesting meal and incidental reimbursement. This step 

is done first to represent all your meals for the travel days. 

In the open expense report, navigate to the right of the Report Details menu and select Travel Allowance > Manage 

Travel Allowance.  

*Note: All employee expense reports require a travel allowance to expense meals and incidentals.

Booking through Concur or our designated Travel Management Company (TMC) streamlines this process.  

Importing the Travel Itinerary 

1. If the traveler booked via Concur or the TMC, on the “Create New Itinerary” option, then select “Import
Itinerary”.
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2. Locate the itinerary and import, then select the appropriate itinerary and navigate to the Adjusting
Allowances section.

Entering the Travel Itinerary 

1. If the itinerary exists, select it from the “Available Itineraries” section, then select “Import”.

2. Once the New Itinerary stop fields are filled out, select “Save”.
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3. If the traveler booked through an external travel agency or online (outside of Concur) , add New 

Itinerary Stops for every location you went to (i.e. spent the night). There is no need to add a stop 
for a layover unless it is overnight. All fields are required. 

4. Select “Add Stop” as needed. 

 

5. Once all overnight destinations are reflected in your itinerary then select “Next”. 

 
Adjusting Allowances 

1. A row for each day displays so you can select more details. 

2. To exclude an entire day as personal, select the checkbox at the left.  

a. Meal rates will be reduced to 75% for first/last day travel and days in between will reflect the full 
per diem rate. For itineraries including personal days of travel for the first or last day, please 
consult your campus with appropriate steps to complete per diem. 

3. Select the checkbox below Breakfast, Lunch, and/or Dinner whenever the meal is provided. 
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4. Any selected meals will be deducted from the allowance the traveler receives. The allowance value at the
right reflects this adjusted amount.

5. When finished, select “Create Expenses”. Expenses will then be automatically added to the Expense

Report. Once created, expense lines can be deleted, however, amounts cannot be altered. To reduce the
report total, if needed, add a negative amount using the Expense Type: Reduction.
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Report Details 

Using the Expense > Manage Expense navigation option displays the Expense Report library where 

expense reports and their current status are visible. Drill further by opening the report and utilizing 
the Report Details menu. 

Report Totals 

After adding expenses to the report, use this option to view the amount the 

traveler owes or what is due to the traveler from the university, and what has 

been paid to the credit card company by the university.  
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Report Timeline/ Tracking Status of an Expense Report after Submission 

You can review the status of your submission by using the timeline.  It will show 

what has occurred thus far and where the report is within the flow. In the 

example below, this report is with the “reports to” approver. For your report, this 

would reflect an actual person’s name.  

1. This view shows the Approval Flow and the current stage of the expense report.

2. This view provides comments and keeps track of when the report was submitted.

3. The Budget Approval name will remain blank until the report is submitted and the system will

then populate this workflow step with the approver name(s) based on the Chartfield(s)
indicated.

4. Adjust the Sort, if desired.

5. Select “Close” when finished viewing the timeline.

Audit Trail 

Using this option a user can view the record of all changes made to an expense 

report once the report is submitted. Actions at the Report Level and Entry Level 

are both tracked.  
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Linked Requests/Manage Requests 

Using this option, a traveler can disassociate or add a travel request from the expense report or view the 

linked travel requests. Multiple travel requests can be linked to a single expense report for a trip that 

begins on the same day another one ends. This can only be done if the report is unsubmitted or returned 

back to the traveler. 

Linked Cash Advances 

Select “Report Details > Manage Cash” to display the Cash Advance window. 
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Adding Expenses 

Adding Expenses from within the Expense Report 

1. From the open expense report, select “Add Expense”.

2. If creating a new expense using the “Create New Expense” tab,

a. Select or search for the expense type.



38 

b. Enter details for the “New Expense”. In this case, enter the Transaction Date, Vendor Name, City
of Purchase, Amount, and Comment. Fields with a red asterisk are required fields.

3. Select “Add Receipt” and upload the appropriate supporting documents. *Select “Upload New Receipt”

to upload or drag and drop files to upload a new receipt. Valid file types for upload are .png, .jpg, .jpeg,
.pdf, .tif or .tiff. 5MB limit per file.
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4. Select “Save Expense” button to close and return to the report or select “Save and Add Another” if
additional expenses must be added to the report.

a. Verify or update the Expense Type classification of the imported credit card transactions or any
other required fields that need to be populated.

5. If creating a new expense using the Available Expenses tab, note that all available expenses done on the
Travel Credit Card/Ghost Card Charges will appear here. Note: Flights purchased through Concur or the
TMC will come into the Available Expenses are as a Ghost Card charge.

a. Select the checkbox next to each transaction that you want to assign to the current expense
report. The Payment Type and Expense Source columns help to identify the method of purchase.

b. Select the “Add to Report” button to move the to the current expense report.

Note: If a checkbox is not selected, the “Add to Report” button will appear light blue.

c. Verify or update the Expense Type classification of the imported credit card transactions. If a

change is required, select the three dots at the far right and “Edit” the transaction.
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6. If creating a new expense using the “Card Transactions” method (window displayed below), 

a. Ensure you have “All Unused Charges” selected in the Time Period field. This will prevent you 

from omitting a charge on your card that is outside of the default range. Select all the charges or 
the individual charges that were for this travel report. This view resembles the Available 

Expenses view. 

 

b. Validate the Report Name in the “Add Charges To” field is valid, then select the “Add Selected” 
button to move the transactions to the report. 

c. Verify or update the Expense Type classification of the imported credit card transactions, 

especially for Meals purchased on the Campus Issued Card. 

Meals Charged on a Campus Issued Card Expense Type 

This expense type will be utilized when a traveler has access to a campus issued travel card and uses it for meals. 

The cardholder is required to report any meals purchased in this way and it will auto deduct the value from the 

M&IE per diem offered through the university. 

7. For Transactions already on the open report, select the expense and then “Edit”.

 

8. Update the expense type to “Meals Charged on Campus Issued Card”, then select “Save Expense”. 



41 

9. CSU and campus specific audit rules are integrated into the system. When adding an expense that

requires a certain action an alert message will appear:

To Create a Car Mileage Expense 

You must register a car for the applicable mileage type in order to be reimbursed for mileage. See Personal Car 

section for instructions on setting up your vehicles. 

1. From within the Expense Report, select “Add Expense”.
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2. Select the “Personal Car Mileage” Expense Type. The mileage form will open with the required and
optional fields displayed.

a. If you are prompted to add a new vehicle, add the vehicle description and “Personal Car” as the
mileage rate type. If not prompted and there is a need to add a new vehicle or modify an existing

vehicle, the same location may be accessed by selecting the “Profile” icon in the upper right
corner of the window, “Profile Settings”, then select “Personal Car”.

3. Select the “Mileage Calculator” button.

4. Type in the locations and select “Calculate Route”.

5. Update the route as appropriate. If round trip mileage should be calculated, select the link “Make Round

Trip”.

6. Only use the Personal checkboxes to the right of each waypoint if you want to omit that portion of

mileage from your report.

7. Select “Add Mileage to Expense”. The amount will calculate as the form closes and all the fields will be
populated on the form. The mileage reimbursement amount automatically updates based on the travel
date and rate effective date.

8. Complete all required and optional fields as appropriate.

9. Select “Save Expense”.
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Expensing a Cash Advance 

If you had a cash advance issued, you will need to expense the cash advance with your expense report for the 

associated trip the advance was used for. Cash advances are reserved for competitive team travel or other 

extenuating circumstances.  

To Expense a Cash Advance (with amount fully utilized): 

At the top of the report, you will see the outstanding advance. This should be the amount you received for the cash 

advance. If the Cash Advance box is not displayed, you can add the advance. 

1. From within the Expense Report, select “Report Details”. Select “Manage Cash Advances”.

2. If no advances are linked, the No Cash Advances Linked message will display.  Select “Add” to link a cash
advance.

3. Select the radio button next to the correct advance, and then select “Add To Report”.

4. Continue to enter your expenses as normal. When you enter an out-of-pocket expense, the outstanding cash
advance balance will reduce.

When the Outstanding Advance balance is zero, then the cash advance has been fully utilized. If you have additional 

out-of-pocket expenses, you will receive the balance you paid out-of-pocket minus the cash advance amount. 
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To Expense a Cash Advance (Excess Funds to be returned to the University): If there are funds not fully 

utilized from the advance after accounting for all expenses, you will see  the amount remaining at the top of the 

screen. The remaining amount must be paid back to the University and the returned amount must be accounted for 

within the expense report. 

1. Enter an expense line for the funds returned as “Cash Advance Return.” Attach the receipt you received from
paying back the advance. This will clear the remaining balance to $0.00. You will now be able to submit the
expense report.

Itemizing Expenses 

Use the Itemize feature to account for transactions that should be charged to multiple expense types (accounts 

codes). Itemization should be completed prior to Allocation (charging to multiple chartfields).  
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To itemize a general expense: 

1. Add the expense as usual and then select Itemizations tab. The itemized amount must match the total
expense. Not all expense types can be itemized.

2. Select “Create Itemization” link, select the expense type that applies to the first itemization. The page

refreshes, displaying the required and optional fields for the selected expense type.

3. Complete the fields as required.

Select “Save Itemization” or “Save and Add Another”.

4. The expense will now reference an “itemized” note under the amount if the line item is able to be
itemized.

5. Repeat for each additional itemization, on the Itemization tab, select the appropriate expense type and

complete the appropriate fields.

To itemize a hotel expense: 

A hotel bill typically contains a variety of expenses including room fees, taxes, parking, meals, telephone charges, 

and maybe personal items. You must itemize these expenses so that they can be reimbursed correctly.  

To create a lodging expense: 

1. With the Expense Report open, on the “Create New Expense” tab, select the Hotel/Lodging expense
Type. The lodging form will open with the required and optional fields displayed.
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2. Complete all required and optional fields as appropriate.

3. Select “Itemizations” tab. The Hotel/Lodging expense type requires itemizing.

4. The number of nights  and days auto populate.

5. Select “Same daily aount”, “Different daily amount” or “Not recurring” depending on the respective
hotel details. If not the same each night (i.e. increase for weekends, etc.) this option will let you note the

differences from day to day, otherwise select same every night to itemize full cost of stay by respective
classification.

6. Enter the Room Rate, Room Tax, and Additional Charges.

7. Select “Save Itemization”.
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If there is a remaining amount to be itemized (other charges, for example, for parking or meals), the 
remaining amount is displayed in the Remaining field. Continue to itemize the amounts until the balance is 

$0.00. For lodging, if Payment Type: Out of pocket, omit any meals and do not include them in the 
itemization/report as you will receive the M&I per diem. 
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Allocating Expenses 

The Allocations feature allows you to allocate selected expenses to multiple chartfields. This should 

be performed after the Itemization if allocating to multiple expense types.  

To allocate a single expense: 

1. Allocate single expense - With the report open, select a single expense and select “Allocate”.

2. Select the Percent or Amount tabs, then “Add” and enter the new chartfield designation. This
accommodates a split distribution and enables areas to share costs.

3. To allocate multiple expenses (or the entire report) at a single time, select the expenses and then select
the “Allocate” button.
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4. Select Percent or Amount, then “Add” and enter the new chartfield designation.

5. Select Save.
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Attachments 

Managing Attachments 

Navigate to Manage Receipts > Manage Attachments menu to launch “Upload Report Level Attachment” window. 

These are files that support the expenses (no need to attach meal receipts when using location based per diem) . 

Documents may include a conference registration showing location/dates of trip, or an itinerary for international 

travel, or any other support document that is helpful to have on hand for processing the travel expense claim. 

1. Valid file types are specified (.png, .jpg or .jpeg, .pdf, etc). Note: There is a 5MB limit.

2. A report option window will provide “Delete”, “Add” or “Open” action buttons for the attachment.
“Delete” will be prompting to remove the current attachment. “Add” is used to insert more attachments.

“Open” is used to view the attachment in full size.

3. Use the X in the upper right if you are finished adding attachments.
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4. Once documents have been uploaded, the Manage Receipts menu displays an additional option to “View
Receipts in New Window”.  *Note: Documents cannot be removed once the Expense Report is

submitted or Appoved. However, more documents may be attached to a report at anytime.

Electronic Receipts (E-Receipt) 

An electronic version of a paper receipt for expenses incurred by Concur users.  Opting into e-receipts can alleviate 

the amount of data you need to type into the system. Some hotels offer receipts which are imported into Concur  

and facilitate the data entry for you.  

1. If a user wants to use e-receipts for car and hotel, they must activate the feature and opt themselves in.

2. Navigate to “Profile” (in the upper right corner of the window), then “Profile Settings”.
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3. Once in the Profile Options window, navigate to the profile settings in the left menu area to a section
called “Other Settings” and select “E-Receipt Activation”.

4. In the main area of the window, select “Enable” to activate the e-receipt functionality.

5. Select “I Agree” to begin receiving car and hotel e-receipts.

6. If at any point you wish to inactivate the settings, select “Disable”
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Missing Receipt Declaration 

1. For missing receipts, open the expense report and select the item for which the receipt is missing then
navigate to Manage Receipts > Missing Receipt Declaration. Note: This is only visible to the Traveler.

Delegate’s do not have access to this create a missing receipt on behalf of the Traveler.

2. Complete the Receipt Declaration by checking the box to confirm the receipt that is missing, then select
the button “Accept & Continue”.

3. The expense report line will display an image to identify that the receipt is missing.

4. Please be aware that a missing receipt declaration cannot be used for all expenses.  The system will alert

you if it cannot be used.

Send Receipt Images to Travelers Available Receipts Library 

The Delegate cannot set up an email account when they are delegating, nor can they use the verified 
email account they have set up for their own expense reports to populate another user's Available 
Receipts Gallery. However, the delegate can upload receipt images to Concur for attachment to the line 
item of the Traveler report they are acting on. The following steps should be completed during profile 
setup: 

1. The Traveler must verify his/her own email address in his/her profile under Your Information, Email
Addresses.

2. The Delegate must verify his/her own email address is in his/her profile under Your Information, Email
Addresses.
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3. The delegate must have the correct delegation permission (can prepare, can view receipts, etc.). To
update delegate permissions, go to Profile > Profile Settings.

4. Navigate to Expense Delegates > Add a Delegate > select Can Prepare and Can View Receipts.

5. Then, the Delegate can email receipts to receipts@concur.com with the correct image extensions and

size (must be a .png, .jpg., .jpeg, .pdf, .html, .tif or .tiff file; 5 MB limit per file).

6. The Delegate must put the Traveler email address in the subject line.

7. The receipt will show in the Traveler Available Receipts gallery within three minutes.

Printing or Sharing an Expense Report 

To Preview and Print the Expense Report 

1. On the Expense Report page, select “Print / Share”, and then select “*CSU-Detailed Report with
Summary Data”.

2. Select Print or Save as PDF or Email to get complete packet for expense report (only PDF and email

includes copies of the report with receipts attached). Please note, copies are retained in Concur
according to our CSU retention guidelines and maintaining duplicative copies elsewhere is not required of
departments. By selecting Email, the recipient will receive an automated email (auto generated email will

not receive replies) with the expense report copy. Audit trail will populate if a report has been emailed.

Reviewing/Approving an Expense Report 

Reviewing an Expense Report 

1. On the home page, scroll down to view all pending approvals in the “Approvals” box.
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OR 

On the home page, in the Quick Task Bar, select the “Required Approvals” option. 

2. The Reports Pending your Approval page lists the awaiting reports. Select the report you want to open.

3. Review the report details:

a. Review dates and locations of expenses compared to the original request.

b. Take note of any personal days on the request and whether expenses were claimed on those
dates.

c. Compare the total amount being claimed for reimbursement with what was requested.

d. Review all expenses for reasonableness and completeness.

Approving an Expense Report 

After review, if you are satisfied with the Expense Report, select “Approve” in the top right corner of the screen. 

The expense report is typically reviewed by the persons manager and the cost object approver (delegated authority 

for the chartfield), however, it is a shared responsibility to ensure we are following guidelines. 

Sending Back an Expense Report 

During your review, you may choose to return the entire expense report to the employee for correction.  
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To return a report: 

1. Select “Send Back to User” located on the top right corner.

2. The Send Back Report window appears.

3. Enter a Comment for the employee explaining why you are returning the report.

4. Select “OK”.

5. The user will receive an auto notification via email that their report has been sent back with the
comment. In addition, a note will appear at the top of the report.

Adding an Additional Reviewer/Approver Step (for HR approvers only) 

You will have the ability to send the report to another approver. To approve and forward a report (as a Reports to 

Approver): 

1. Select the “Approve & Forward” button in the top right of the screen.
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2. Enter the User-Added Approver, and add a comment, as needed.

3. Select “Approve & Forward” to approve the Expense Report and send to the next approver.

Adding An Additional Approver (for both HR Approver and Budget Approver/Cost Object 

Approver[COA]): 

1. Select “Details”, then “Approval Flow”
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2. Select the addition sign next to your approval field that states “Add a step after this step” or “Add a step
before this step”.

3. Enter the User-Added Approver. Do not add an additional approver after the Approval for Processing

Step. The Processing step should be the last step in the workflow.

4. Select “Approve”.

Expense Delegates 

Adding an Expense Delegate 

There may be a time when you want another person to assist with submitting a travel request or expense report 

claim. Please be aware that Request and Expense share delegates. By assigning permissions to a delegate, you are 

assigning permissions to both Request and Expense. To delegate access to another person, complete the following 

steps: 

1. Open your profile by navigating to Profile > Profile Settings.
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2. Using the far left menu, within Expense Settings select the “Expense Delegates” option OR select
“Expense Delegates” from the main section.

3. Navigate to the Delegates tab to assign another employee rights to request travel or to process an

expense report on your behalf.

4. Select “Add” for each supplemental employee who needs access.

5. After selecting “Add”, then begin to type the person’s email address, employee ID or name.

6. Select the correct name from the list results.

7. After selecting the name, enter checkmarks in the boxes to the right of the name to grant appropriate
access.

8. Use caution when delegating approval rights.

9. Only if you have Approver permission, will you have the approve permission boxes.

10. To place a limit on the approval timeframe, use the “Can Approve Temporary” date fields. Note: Not all
options may be available to all users. Delegate options are based on the individual user profiles access
within Concur.



60 

11. Continue adding names as needed.

Removing Delegation Rights 

1. Open your profile by navigating to Profile > Profile Settings.

2. Using the far left menu, within Expense Settings select the “Expense Delegates” option OR select

“Expense Delegates” from the main section.

3. Select any names for which you want to remove access. Select “Delete”.

4. The “Delegate For” tab will display the individuals which have granted you Delegate access to their
profile.

5. On that tab, select any names for which you want to remove access. Select “Delete”.

6. The Delegate can also delete themselves from being your delegate.
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Acting as a Delegate 

If you have been assigned to work as a delegate, your delegator will define which tasks you can complete, such as 

preparing reports or approving, etc.  

To work as a delegate: 

7. Select the “Profile” in the upper right.

8. On the Profile window, select “Act as Another user”.

9. Select the appropriate delegator's name from the drop down or type the name in the following format:
Last Name,First Name

10. Select “Switch” to begin working as the other person.

11. Notice that the Profile menu now displays Acting as and displays the name of the employee who

delegated their access.

12. You are now officially working on behalf of that person. Complete the normal processes for creating the
request as noted in the section labeled Creating a Travel Request.

13. Once the request is built, the Delegate can use the “Notify Employee” button to let the traveler know the
Request is ready to submit. The Traveler must certify and submit their own travel.

14. To return to your own tasks, select “Acting as”, then select “Myself” and “Switch”.
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Delegate Roles 

Option Description 

*Can Prepare If selected, the delegate can create expense reports and 

requests on your behalf.  

*Can View Receipts If selected, the delegate can view receipt images on your 

behalf.  

*Receives Emails If selected, the delegate receives a copy of each Expense 

related email that you receive, except for approval emails. 

Can Preview for Approver If selected, the delegate can preview requests and expense 

reports on behalf of another employee. This delegate cannot 

approve the request/expense report. 

Receives Approval Emails If selected, the delegate receives a copy of each Expense 

approval-related email that you receive.    

(*) Can Approve If selected, the delegate can approve expense reports, and 

requests on your behalf, without date constraints.  

(*) Can Approve Temporary If selected, the delegate can approve expense reports and 

requests on your behalf but only for the specified period. If 

you select this option, you must also select the beginning and 

ending date.  

(*)  The option to delegate approver rights will only be available for Approvers in the system. The approver’s rights 
can also only be delegated to another user who also has approval rights in the system. This function can be used 
for times when an approver is unavailable and approval tasks will be covered by another person in their absence 
(i.e. Dean unavailable and approvals would be routed to Provost).  
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Correcting and Resubmitting an Expense Report 

Your Expense Report Approver or processor will send a report back to you if an error is found. You will 

receive an automated email from Concur with a report status change of: Sent Back to User with a comment. 

The Approver or Processor will include a comment explaining why the report was returned to you. To 

identify and correct expense reports requiring resubmission: 

1. On the home page, in the Quick Task Bar, select the Open Reports tile. In the Manage Expenses section
of the page, the report appears with Returned header on the report tile. The approver's comment
appears below the amount.

2. Select the report tile to open the report.

3. Make the requested changes.

4. Select “Submit Report”.



64 

Special Travel Situations 

Travel Prior to the Per Diem Policy change 

If the traveler is claiming for a trip that occurred before the per diem policy change, when selecting the itinerary, 

select the “Per Diem (Travel pre 1.1.24) option to complete the transaction. This is only necessary for international 

travel prior to the per diem implementation.  

For domestic travel prior to 1/1/24, travelers can use the specified expense types as follows: 

1. Breakfast – Domestic (Travel prior to 1-1-24)

2. Dinner – Domestic (Travel prior to 1-1-24)

3. Lunch – Domestic (Travel prior to 1-1-24)
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Converting Foreign Currency Transactions 

1. With the Expense Report open, select Add Expense, and then enter the appropriate information in the
required and optional fields (required fields are indicated with a red asterisk).

2. For the Amount field enter the amount spent in foreign currency. The correct currency should populate
based on the City of Purchase information you entered. If needed, you can change the currency from the

list to the right of the Amount field.

3. Expense calculates the amount in USD.

4. If expense amount is already in USD, enter amount in Amount in USD field and it will calculate the foreign
amount for you.

5. Complete the remaining fields as appropriate and make sure the Travel Allowance box is checked before

saving the expense. This is what will be used to check the amount against the GSA travel allowance rates
for that specific destination. If this box is not checked the report will not be able to be submitted until

that occurs.
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Support Documents for Inter campus Fund Transaction (IFT) Submission 

IFTs are CSU transactions between (1) a campus and the CO or (2) between two or more campuses. The CO 

facilitates the movement of monies between campus funding sources by way of an IFT (journal entry). The CO 

generally requires copies of the expense report and related receipts, depending on the allocation involved. The 

awarding department at the CO/campus will generally give recipients/participants instruction on what will be 

reimbursed and the department will have to decide if they will cover any variance that may occur between 

reimbursement allowed by CSU procedures and allocation received by the CO/campus.  

In consultation with the CO Accounting team, a copy of the expense report from Concur and the supporting receipts 

can be utilized for IFT support in lieu of copies provided under paper environment. Sometimes the CO asks for 

receipts that are not required by the policy – it will be important for travelers/departments to retain those 

additional copies IF an IFT is in play or until these additional requirements are no longer exercised.  

1. In Concur, go to Expenses > Manage Expenses and select the View drop-down arrow to the right of
“Active Reports” to display other report options and ranges for active or submitted expense reports.

2. Select the correct expense report and then choose “Print/Email” link and select “CSU-Detailed Report

with Summary Data.” Print this report to PDF. The PDF version will also contain the related receipts that
were attached. This file can then be sent to the appropriate CO contact or campus accounting team for
IFT support.
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Creating an Allocation Favorite 

1. Log in to SAP Concur

2. Open the expense report

3. Select the expense entry and select Allocate

4. In the prompted window, select Add New Allocation to add as many allocations as necessary

5. Modify the amounts/percentages and the other fields as desired ( the allocated amount must sum up to

exactly 100.00%)

6. Select Add to Favorites

7. Enter the Allocation Favorite name and select Save

8. Select Save in the allocation window, then OK and Done

To use a Favorite Allocation:

a. Log in to SAP Concur

b. Open the expense report

c. Select the expense entry and select Allocate

d. In the prompted window, select Favorites and select the desired Favorite Allocation

e. Select Yes to apply the Favorite Allocation to the entry

f. Modify any values, if necessary

g. Select Save in the allocation window, then OK and Done
To remove a Favorite Allocation from the user account:

i. Log in to SAP Concur

ii. Open the expense report

iii. Select any expense entry and select Allocate

iv. In the prompted window, select Favorites

v. Next to the Favorite Allocation to be removed, select the x sign

vi. Select Yes to confirm
To update an existing Favorite Allocation:

1. Log in to SAP Concur

2. Open the expense report

3. Select any expense entry and select Allocate

4. In the prompted window, select Favorites and select the desired Favorite
Allocation to be updated

5. Select Add to Favorites

6. Enter the same name for the updated Favorite Allocation and select Save

7. Select Yes to confirm




